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Why should I use PowerPoint in my classroom?
For Teachers:
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

•
•
•
•
•
•
•

PowerPoint is an engaging instructional tool
No more “stand and deliver”
You can make direct instruction a visual and auditory learning activity by
incorporating video clips, audio clips, text, and graphics
Keeps the presenter on track and organized
Easy to update or change
No more drawing graphs and charts on poster paper–create it once and
you’re done
Saves time drawing a complex equation on the board–do it once!
Won’t get mixed up like overhead pages when they’re dropped on the
floor
You can stop and know where to start after lunch, a fire drill, or the end
of the class session
Teams know what the other teacher has presented
You can share the presentations with the next grade level for review
Upper grade teachers can print the slides as handouts for student note
taking
E-mail your presentation to absent students or send it with a vacationing
student
Differentiated instruction–create remedial or GATE lessons for student
viewing
Send important information home to parents (bicycle safety)
Self-checking games and learning centers

For Students:

Students can review your presentations when needed
Students have to know more than the words on the slide
Groups can create parts of the presentation and put it together
Fun, interesting way to talk to the class
Great way to showcase projects for families and guests
Create the slides and exchange information with online collaborative
projects and e-pals
Electronic Portfolios

When allowing students to use PowerPoint as a presentation tool, make sure
they have a presentation, not just a group of slides. Require them to research
and create a paper or detailed information about their topic. The PowerPoint
presentation should be the “outline” not the information.

Microsoft PowerPoint in the Classroom

p. 2

What are some ways to use PowerPoint in my classroom?
•
•
•
•
•
•
•
•
•
•
•
•

Direct instruction, Review
Label a map and use it for identification
13 Colonies, European countries
Pictures of animals for classification or habitat
Games (teacher created and pre-done downloads)
Spelling Word and Vocabulary introduction or review
Introduce prefixes (unicycle, bicycle, tricycle) with photos
Introduce new unit-step by step such as ancient Greece
Post student projects to the web
Post lessons/presentations to the web
Continuously running Open House Presentation
Create a photo essay to study fashion trends
Create class books and permanent records of projects

Do I have to create new presentations all the time?
No, check out these websites for ready made presentations

Astronomy:
http://www.astro.ufl.edu/public/multimedia/
Games:
http://www.grand-blanc.k12.mi.us/pptgamedownload/
http://www.teachnet.com/lesson/misc/winnergame022500.html
Project Ideas:
http://electricteacher.com/powerpoint.htm
http://www.education-world.com/a_tech/tech013.shtml
Technology workshop and colleague presentation:
http://school.discovery.com/schrockguide/ppoint.html
Multiple Subjects:
http://www.nebo.edu/nebo/ppt/
http://personal.monm.edu/baker_marie/powerpoint00.htm
http://personal.monm.edu/baker_marie/powerpoints01.htm
Kindergarten Units:
http://jf048.k12.sd.us/butterflies.htm Butterflies
http://4dw.net/besteacher/ppt.html Class book ideas
http://4dw.net/besteacher/pptshow.html Book of colors
Science and Social Studies (K-5)
http://www.seaford.k12.de.us/it/pp/home.htm
Writing Process:
http://owl.english.purdue.edu/workshops/pp/
Work in grade level or district teams to create and trade presentations on
standards and thematic units.
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What else can I do with PowerPoint?
Sites for additional tutorials: (for you, parent volunteers, and students)
http://www.online.tusc.k12.al.us/tutorials/pptclass/pptclass.htm
http://www.internet4classrooms.com/on-line_powerpoint.htm
http://www.west.asu.edu/achristie/powerpoint/
http://cit.duke.edu/resource-guides/methods-powerpoint-presentations.htm
Games and Classroom Ideas:
Designing your own “uncover” game: (intermediate)
http://rcs.rcps.k12.va.us/creativeways/undercover.htm
Designing your own games: (advanced)
http://soe.cahs.colostate.edu/cttec/PDF/designing_interactive_games.pdf
How to make a class book (lesson plan)
http://panther.bsc.edu/~lelokey/PowerPoint_Book_lesson_plan.htm
Sample Back-to-school night presentation
http://www.d91.k12.id.us/sunny/classes/jackson/Backtoschoolpres3.htm
Sources for Free Clip Art: Be sure to search the web for additional sites.
http://www.edselect.com/clipart.htm
http://www.teachnet.com/how-to/clipart/
http://www.theteachersguide.com/Freebies.html
http://www.free-clipart.co.uk/education_clipart.shtml
Digital photographs and paintings of historic significance in American history:
Library of Congress Digital Library Information:
http://memory.loc.gov/ammem/ndlpedu/lessons/primary.html#object
US National Archives & Records Administration:
http://www.archives.gov/index.html
General information lesson plans and ideas:
http://www.brainybetty.com/educators1.htm
Information on Copyright Issues:
http://www.techlearning.com/content/outlook/pdq/2003/4-15.html
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How to create the Jeopardy Game using the blank template:
Go to slide one and type in your categories.
Choose the second slide and double click on it.
Begin typing your first answer.
Double Click on slide 3, and type your question.
Remember the format of Jeopardy. The answer is in the form of a question
Each slide is in order, going down the category e.g.:
First category for 5 points is slide number 2 and 3.
First category for 10 points is slide number 4 and 5 etc.
by Eleanor Savko
http://www.trimble.k12.ky.us/Creating%20a%20Jeopardy%20Game.doc
To download Ms. Savko’s version of Jeopardy go to:
http://www.trimble.k12.ky.us/BlankJeopardy.ppt
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When using PowerPoint in the Primary Grades:
Have a parent volunteer work with the students to create the slides and setup
the presentation. You want the students focused on their research and
storyboard.
Use more teacher created presentations, games, and activities.
When using PowerPoint in the Upper Grades:
Work with the computer lab teacher to have the students learn the basics of
slide creation.
Have parent volunteers ready to assist when students are working on the
slides in the classroom. You still want the students focused on their research
and storyboard.
Use teacher created presentations, games, and activities.
Have students take notes on the handouts.
All Grades:
Ask parents to install the PowerPoint viewer on their home computer so they
can view the presentations from your class website or e-mail.
http://office.microsoft.com/downloads/2000/Ppview97.aspx
Other Useful Technology:
Digital Camera
Scanner
Digital Projector
Connection to large screen television (this could be fuzzy)
Laser Pointer and/or Wireless Remote Presenter
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How do I grade PowerPoint presentations?
Many teachers create basic multimedia rubrics and checklists for PowerPoint
presentations at the beginning of a school year and adapt them for each
project. I would encourage you to involve your students in the creation of these
rubrics and to always present the rubric as the assignment or unit starts.
Jamie McKenzie suggests that teachers create multimedia rubrics that focus on
content, originality, and style. In How Teachers Learn Technology Best, he
offers these suggestions:
•
•
•
•
•

Is the presentation original and inventive? Students should not
“plagiarize” other sources (proper documentation of sources is
required).
Does the “glitter” contribute to the effectiveness of the presentation?
Is the quality of the presentation grade level appropriate?
Does the written storyboard support the presentation? (Or written report)
What resources are the students using? A mixture of print and Internet
should be required.

Check out Jamie McKenzie’s article “Scoring Power Points” at
http://www.fno.org/sept00/powerpoints.html
The University Of Northern Iowa has set up an excellent web resource for
rubrics. Cooperative grouping, research reports, PowerPoint, and other
multimedia rubrics are included. This is a great starting place.
http://www.uni.edu/profdev/rubrics/pptrubric.html
Tech Trekers has links to online rubric builders.
http://www.techtrekers.com/rubrics.html
Think 2 Learn has created a webpage of links to PowerPoint tutorials, teacher
presentations, student presentations, and rubrics. This is a well designed
starting page.
http://www.think2learn.com/powerpoint/pages/resources.htm
On the following page is a rubric to evaluate a PowerPoint presentation created
for participating teachers in an Induction program. It includes categories for
planning, content, layout, graphics, and the actual presentation. As the
teacher, you would probably want to include more on the student’s actual oral
presentation.
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PowerPoint Rubric
Activity

Incomplete

Proficient

Exemplary

Planning

No evidence of
preplanning for
presentation.

Preplanning was
adequate to enable
the PT to prepare the
presentation.

Preplanning enabled
the PT to construct
their presentation
easily and quickly.
Preplanning shows
evidence of logical
sequence for material,
attention to
background, fonts,
colors, and
transitions. URLs and
graphics are listed for
insertion.

Additional planning
would enable the PT
to more efficiently
create their
presentation.

Content

Content was weak, or
incorrect. No
evidence of research.

The content is written
in a logical sequence.
Information is
accurate and
effective.

Text Layout

Difficult to read due
to use of paragraphs,
dark fonts, and noncontrasting
backgrounds.

Fonts are easy to
read and point size
varies to enhance
readability of the
text.
Some lengthy
information is included
on slides.
Graphics enhance the
presentation and are
to the side of the
slide.

The content is well
organized and
appropriate to the
audience.
Material is correctly
documented when
appropriate.
Font size and color
changes for text
emphasis and titles.
Use of italics, bold
and underline enhance
the readability of the
text.

Text is appropriate
length for audience.

Bulleted lists are used
effectively.
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PowerPoint Rubric
Activity

Incomplete

Proficient

Exemplary

Graphics, Sound,
Transitions

No graphics, sound, or
transitions are used in
the presentation.

Graphics, sounds, and
transitions are used in
the presentation.

Graphics, sound, and
transitions are used
appropriately and
enhance the
presentation.

They are generally
used appropriately
and enhance the
presentation.

Save and Print

Presentation

PT cannot save the
presentation without
help.

PT can save the
presentation.

PT cannot print the
presentation without
help.

PT can print the
presentation. PT has
difficulty printing in
multiple formats.

PT did not give the
presentation.

PT gave the
presentation.

Design elements
combine with content
to create a high
impact presentation.
PT can print the
presentation in
multiple formats such
as 3, 6, or 9 to a
page.
PT can save
presentation as an
HTML document.
PT’s presentation was
enhanced through the
use of the slides and
handouts.

Sources for rubric http://www.ncsu.edu/midlink/rub.mm.st.htm
http://www.uni.edu/profdev/rubrics/pptrubric.html

Participating Teacher’s Name
Participating Teacher’s PowerPoint Presentation has been scored as:
Incomplete

Proficient

Exemplary

Professional Development Provider Signature
Date
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OBJECTIVE 1: CREATE A NEW PRESENTATION

1.

Launch PowerPoint.

2.

Ensure that Blank Presentation is selected in the Create a New
Presentation Using radio button group. If it isn’t, simply click on the radio
button. (Remember, radio buttons are mutually exclusive – only ONE
within the group can be selected.)

3.

Click OK.

4.

Normally, the New Slide selection window (Figure 1) will appear. If it
doesn’t (PowerPoint can be configured such that this window does not
automatically appear), simply pull down the Insert Menu, then select New

Figure 1: New Slide Window
Slide (or press CTRL-M). On the New Slide selection window, choose from the
available slide layouts by clicking on the design desired, then click OK.
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5.

Once the type of slide is selected, the “Normal” PowerPoint view (Figure 2)
will be on the screen. This is where you’ll do most of your slide creation
and editing. The screen is composed of two distinct panes. On the left,

Figure 2: PowerPoint’s Normal View
your outline will be displayed, and on the right is the currently selected slide.
6.

To continue adding slides, pull down the Insert Menu, then select New
Slide (or press CTRL-M). On the New Slide selection window, choose from
the available slide layouts by clicking on the design desired, then click OK.
Repeat as necessary.
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OBJECTIVE 2: FORMATTING SLIDES
There are many ways to format slides in PowerPoint. Although adding text and
graphics are the most basic ways to format your slides, you can also add
colorful backgrounds, use different fonts, add sounds and do many other things
that will help your audience pay closer attention. In this lesson, we’ll cover
each of the following formatting techniques:
1. Adding and formatting Text
2. Adding a Background Color
3. Adding a Color Scheme
4. Applying Design Templates
5. Adding Graphics

Adding Text to Your Slides
1.

When you’ve selected a new slide format and the new slide is on the
screen, click in any of the text areas on the slide to add your text. When
you click in a text area, the PowerPoint prompt will disappear and be
replaced by a cursor. When you’re finished, don’t press RETURN or TAB, as
either will be inserted into the text. Just click on a new text area to
continue working, or right-click in the current text box to change the
formatting of your text.

Formatting Text
1.

It’s very easy to change fonts,
alignment and other text attributes
while in PowerPoint. First, you need to
decide what text you want to change,
and select it using the mouse. Then,
right-click anywhere in the selected text
area, and select FONT (see Figure 3).
This will allow you to change many
parameters regarding the text you have
selected (font, size, color, alignment,
etc.)

Figure 3: Formatting Selected Text
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2.

After you’ve selected FONT from the
menu, the Font Window will appear (see
Figure 4). This window’s option allows
you to change each of the following
parameters: Font, Font Style, Size,
Effects (Underline, Shadow, etc.) and
Color. Also, by checking the Default
for New Objects checkbox, all
subsequent text you create in this
presentation will have the parameters
you select here.

Figure 4: Font Window

Changing the Slide Background Color
1.

To change the background color of your slide,
pull down the Format Menu and select
Background. The Background Window (Figure
5) will be displayed, which will allow you to
change the background color of either the
current or all slides in your presentation. Simply
use the drop down box (which currently shows
white) below the sample window to display a
list of colors for your background. From this
drop-down box, you may also select custom
colors and patterns for your slide background.

Figure 5: Background Window
When you’re satisfied with the background color
(use the preview button to see what your color will look like), click either
the Apply button (to apply the new color to the current slide only) or the
Apply to All button (to apply the new color to ALL slides in your
presentation).
2.

Changing the Color Scheme
1.

The color scheme of your presentation
takes into account all of the objects
within your presentation, including
bullet points, text, backgrounds,
objects and graphs. To change the
color scheme, pull down the Format
Menu and select Color Scheme. The
Color Scheme (Figure 6) will be
displayed, which will allow you to
change the color scheme of one or all of
Microsoft PowerPoint in the Classroom
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the slides in your presentation.
2.

You may either select from one of the pre-formatted color schemes, or
select the Custom Tab at the top, and create your own scheme. The
custom tab allows you to change colors for each of the following
parameters: Background; Text and Lines; Shadows; Title Text; Fills;
Accent; Accent and Hyperlink and Accent and Followed Hyperlink. Each of
these colors will remain consistent throughout your presentation if you
select Apply to All when you are finished.

Using Design Templates
1.

PowerPoint has included a number of pre-designed templates that make
presentations look professionally produced. Selecting these is easy, and
they do add both style and impact to your presentations.

2.

To select one of these templates, pull
down the Format Menu and select
Apply Design Template. The Apply
Design Template (Figure 7) will be
displayed, which will allow you to
browse through and select one of the
many included templates that are
shipped with PowerPoint. You’ll notice,
as you scroll down the list of available
templates, each template’s design is
displayed on the right hand side of the
Figure 7: Apply Design Template Window
window. To select the currently
displayed template, simply click Apply. Note that when you select a
design template, it is automatically applied to the entire presentation, not
just the current slide.

Adding Graphics to your Slides
1.

Not all slides have positions for graphic
elements, but some formats do contain boxes
that are pre-defined for the insertion of
graphic elements. When you have selected
one of these slide formats, the box for the
graphic will contain the following text:
“Double click to add clipart”. PowerPoint
comes with many different clip-art designs,
all of which are categorised for easy retrieval.
When you double click on the graphics box,
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the Microsoft Clip Gallery Window (Figure 8) will appear and allow you to select
a graphic from it’s myriad choices. Please note that the clipart gallery is
limited in what it contains until you begin to fill it up with graphics of your
choosing.
2.

Once you’ve selected your clip art, it will be inserted into the graphics box
on your slide. If that graphic is the right size, you’re finished. If you’d like
to resize or move it, proceed to step 3.

3.

To resize or move your graphic, first click on
the graphic once. You’ll notice that the
graphic should now have eight “handles”
(Figure 9). These handles assist you in
resizing the image. Before we try anything,
let me describe each of the handles and their
purpose.
a.

First, the four corner handles will allow
you to resize the graphic in both the X
and Y dimensions simultaneously. In
other words, you can stretch the graphic
Figure 9: Graphic “Handles”
both vertically and horizontally. As you
move your mouse pointer over the corner handle, the pointer changes
to a diagonal double-ended arrow, signifying that this handle enlarges
or shrinks the graphic along both axes. To do this, click and hold on
any of the corner handles and move your mouse around. You’ll see
that you can stretch the graphic to make it bigger or smaller. You’ll
also notice that the graphics proportions remain the same (i.e., you
can’t stretch vertically without stretching horizontally). This
proportional resizing is called constrained resizing.

b.

The four handles that are in the middle of each of the four sides of
your graphic allow you to resize the image (bigger or smaller) in only
one direction. You’ll notice that as you move your mouse pointer over
the corner handle, the pointer changes to a double-ended arrow,
oriented perpendicularly the side that you’re mouse pointer is on,
signifying that this handle enlarges or shrinks the graphic along both
axes. To do this, click and hold on any of the corner handles and move
your mouse in the direction of the arrows. You’ll see that you can
stretch the graphic to make it bigger or smaller. You’ll also notice that
the graphics proportions DO NOT remain the same (i.e., the graphic
stretches in one direction only, which distorts the image).

c.

To MOVE the image, click and hold anywhere inside the image (i.e., not
on a handle) after you’ve selected it. The image will now move with
your mouse until you release the mouse button.
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OBJECTIVE 3: TRANSITION EFFECTS
Transition effects are sounds and graphic effects that are initiated when you
change from one slide to another. PowerPoint provides many interesting
effects and sounds that can be used as transitions. As in most other areas of
PowerPoint, transition effects can be specified for individual slides, or for the
entire presentation.

Adding Transition Effects
1.

You can open the transition effects
window from almost anywhere in
PowerPoint. Pull down the Slide Show
Menu, and select Slide Transition. The
Slide Transition Window will appear
(Figure 10).

2.

The Effect box in the Slide Transition
window controls the type of visual
(graphic) transition only. Using the
drop down box, you can select from
transitions such as Fade through Black,
Uncover Up and Wipe Down. Each is
completely different, and as there is no
preview, you’ll have to experiment.
There’s also a radio button for the
speed of the transition, either Slow,
Medium or Fast.

Figure 10: Slide Transition Window

3.

The Advance Box in the Slide Transition Window controls how the
presentation advances to the next slide. This can be either timed
(automatic) or manual, via a mouse click. Since presentations seldom take
the same amount of time on each slide (or for each presentation), slides
are usually advanced manually.

4.

The Sound Box in the Slide Transition Window allows you to add a sound to
each slide transition. Sound files for this purpose are included with
PowerPoint. Simply use the drop down box to select one of the sounds.

5.

After selecting your transition effect and/or sound for your slide transitions,
you may either click Apply to add these effects to the current slide, or click
Apply to All to add them to your entire presentation.
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Adding Custom Animations
Custom animations can be added to each OBJECT on your slide, including
graphics and bullet points (text objects). Usually, they are associated with
bullet points, where each bullet point zips in from the side of the screen (or
uses some other cool effect to pop into existence). But care needs to be taken
with these, since if you add one text object with three bullet points in it,
they’ll only perform one wonderful animation, not three. So what you need to
do is create additional text objects, and put one bullet point in each object –
then add the custom animations to the three separate objects. Here’s how to
do that:
1.

2.

First, since you already know how to create a
new slide, please do so. Pick the second
slide example from the left in the top row
(see Figure 11), and click OK. This slide has
two text objects: A title area, and a text area
for bullet points. Once you get it on the
screen, put some sample text in the Title
area and then let’s concentrate on the text
area for the bullet points.

Figure 11: Pick the highlighted slide

Type in the text for the first bullet
point. Make it no longer than one line.
But do not press ENTER (or RETURN) at
the end of the line. That would create
a new bullet point, and that’s what we
don’t want. Since the cursor is still
flashing where you left it, and the
entire text object is still selected (see
the eight handles on the text object?),
let’s make the whole text object
smaller. What we want to do is grab
the object handle in the center of the
bottom edge of the text object (move
Figure 12: Resized Bullet
the mouse over the handle until the
mouse pointer changes to a vertical double-headed arrow) and drag it UP
until the text object is just big enough to hold our single, bullet point. See
Figure 12 for what the slide should look like when you’re done.
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3. Now let’s make a duplicate of the
bullet. With the first bullet point still
selected (if it’s not, just click on it),
Pull down the Edit Menu and select
Copy. This copies that object to the
clipboard. (Note: If the Copy selection
isn’t available, click on the border of the
text object so that the cursor isn’t
flashing in the text any more, then try
again.) Without moving anything else,
let’s add a duplicate of the first bullet
on the screen by pulling down the Edit
Menu again and selecting Paste. This
Figure 13: Add Second Bullet
creates a duplicate of the first bullet on
the screen, but it overlaps our first bullet a little. To move it off of the
first bullet, move your mouse either onto the line surrounding our new
bullet, or just inside the margins of the line. The mouse pointer will
change to a four-pointed arrow, which let’s you know that you can move
the object around on the screen. Move it to a position below the first
bullet, and aligned nicely with it. See Figure 13 for what the slide should
look like now.
4.

Change the text in the second bullet to something else. Click anywhere on
the text, and you’re back to editing!

5.

With the second bullet still selected (but make sure you’ve changed the
text), make a third bullet by following the instructions in step 3 again. Go
ahead and align that bullet below the second bullet, and change its text as
well.

6.

Now we’re ready to apply our custom
animations to the three bullets. To do
this, pull down the Slide Show Menu
and select Custom Animation. The
Custom Animation Window will appear
(Figure 14). You’ll note that the top
left box shows one title and three text
objects that can be animated. The
bottom of the box has the Order and
Timing Tab Selected. First, let’s select
Text 2 for a custom animation by
clicking the check box in the upper left
Figure 14: Custom Animation Order
window. Note that Text 2 is actually
your FIRST bullet point, which is now highlighted on the sample slide, and
also appears in the Animation Order Window on the bottom. Let’s make
sure that the On Mouse Click radio button is selected in the Start
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7.

8.

Animation Box on the bottom right. That means that the bullet point won’t
appear automatically, we have to click the mouse after the slide is
displayed for it to appear.
Now, with Text 2 highlighted in the
Animation Order Window, click on the
Effects Tab and let’s add an effect to
our first bullet point. Selecting the
Effects Tab displays a completely
different bottom half of the Custom
Animation Window, as shown in Figure
15. This window allows us to select the
entry animation, sound, how the text is
introduced, and what to do after the
animation is done. Let’s select the Fly
animation from the first drop down
Figure 15: Custom Animation Effects
menu, and From Right from the second
drop down menu. And just because we can, select the Whoosh sound from
the long drop down box below the first two. Take a look at the rest of the
options on the page, but we won’t be changing them for this example.
Now do the same to the second and third bullet points (Text 3 and Text 4,
respectively) by following the instructions in Steps 6 and 7 again if you
need to. Don’t leave this window, just select the Order and Timing Tab
again to start working with a different text object.
Now when you play your presentation, you’ll have to click the mouse three
times once this slide is displayed, once for each bullet point. Each of the
bullet points will whoosh in from the right-hand side of the slide.
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OBJECTIVE 4: ADDING SOUNDS TO YOUR PRESENTATION
Adding sounds to your entire presentation is simple, and can provide a
soothing background that lessens the other distractions that can affect your
audience. Sound files are generally “looped” (played over and over) until the
presentation is completed.

Adding Sounds to your Presentation
1.

Open the Sounds Window by pulling down the Insert Menu and selecting
the Movies and Sounds menu item. Selecting this menu item will expose
a flyout menu, with a number of menu items from which to choose. Since
we’re concerned with Sounds, there are four menu items that apply to us.
I’ll describe each below. Please note, all sounds added apply ONLY to the
current slide, not to the entire presentation.
a.

Sound from Gallery
i.
This option opens the Microsoft
Gallery (Figure 16) which displays
many categories from which to
choose sounds. Note that, by
default, PowerPoint does not load any
sounds into the gallery. However,
the Gallery does have a menu item
called Clips Online. Clicking this
menu option (as long as you have a
connection to the Internet) takes you
to a special website that has sounds
and clip art that can be used in
PowerPoint.
(1) Use the search feature on the left
Figure 16: Microsoft Gallery
side of the page (using the
criteria specified below) to help you find some of the sounds
on the site.
(a) Search For:
Sound
(b) Search In:
Everywhere
(c) Results Should Be:
Sounds
(2) Using these criteria, the site should display more than 80
pages of sound files for you to use. To preview a sound, click
on its icon. To download a sound to your computer, click on
the icon with a Downward-Pointing red arrow on it. This will
download the clip onto your hard disk, and will place it in the
Microsoft Gallery, in the Music category.
(3) To apply the sound that’s now been downloaded into the
gallery, do the following:
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(a) First, (if you haven’t already) close the website that has
the sounds on it.
(b) In PowerPoint, pull down the Insert Menu, click on the
Movies and Sounds menu item, and select the Sound
from Gallery menu item on the flyout.
(c) After the Microsoft Gallery window (Figure 1) opens, select
the Music category. Your sound should be located here.
To select it, click on it, and select the top icon (Insert
Clip). Then close the Microsoft Gallery window.
(d) PowerPoint will ask if you want the sound to play
automatically, or if it should play when you click on it. For
our purposes, click Yes to have the sound play
automatically. Then move the sound icon (which looks like
a loudspeaker in the center of the slide) down to the
bottom left corner of the slide by dragging the icon there
with your mouse.
b.

Sound from File:
i.
The Sound from File option
requires that you already have
a sound file on your computer
that you wish to add to your
presentation. Selecting this
option brings up the Insert
Sound Window (Figure 17),
which looks just like the
Windows Explorer, and allows
you to navigate around your
computer and locate the sound
Figure 17: Insert Sound Window
file you want.
ii.
By default, the Insert Sound Window begins looking in the
\Program Files\Microsoft Office\Office directory. Normally,
Microsoft Office installs a file there called TESTSND.MID, which you
can use as a test file for your sounds. To select that file, highlight
it, and press OK.
iii. After selecting that file, PowerPoint will ask if you want the sound
to play automatically, or if it should play when you click on it. For
our purposes, click Yes to have the sound play automatically.
Then move the sound icon (which looks like a loudspeaker in the
center of the slide) down to the bottom left corner of the slide by
dragging the icon there with your mouse.

c.

Play CD Audio Track:
i.
The Play CD Audio Track option allows you to pick a track on a CD
(one that is already located in your CD-ROM drive) while your slide
is being displayed.
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ii.

iii.

iv.

v.

d.

The CD-ROM must be in your computer’s FIRST DRIVE (i.e., lowest
drive letter) capable of playing an audio CD, even if that drive is a
DVD-ROM drive. Otherwise, PowerPoint will not recognise the CD.
Select this option by pulling down the
Insert Menu, selecting Movies and
Sounds, and finally by clicking on
Play CD Audio Track on the flyout.
This will cause the Movie and Sound
Options Window (Figure 18) to be
displayed. Note: If you’ve put your
CD into the correct drive, the last
track number (i.e., number 14 in
Figure 18) will be displayed. If both
the starting track and ending track
display 1, then your CD isn’t being
recognised, it’s in the wrong CD/DVDROM drive, or it only has one track on
it.
Figure 18: Movie and Sound Options
You can use the up and down toggles
Window
to select any individual or sequence
of tracks that you’d like played, or
any segment of a single track, using the time indicators. Once
you’ve selected the tracks and/or times, and whether or not you’d
like to loop the selection (play it over and over until you move to
the next slide), click OK.
After selecting that file, PowerPoint will ask if you want the sound
to play automatically, or if it should play when you click on it. For
our purposes, click Yes to have the sound play automatically.
Then move the sound icon (which looks like a CD-Rom disc in the
center of the slide) down to the bottom left corner of the slide by
dragging the icon there with your mouse.

Record Sound:
i.
This feature allows you (assuming that you have the proper
equipment) to record a sound and have it played on the currently
selected slide. This document will not cover this topic in detail,
since it’s an advanced concept.
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OBJECTIVE 5: PRINTING YOUR PRESENTATION
There are a number of helpful options when it comes to printing presentations
from PowerPoint. You can print slides with notes for presenters, handouts for
students, and even traditional transparencies (with the proper media and
printer combination).

Printing your Presentation
1.

First open the Print Window by pulling down
the File Menu and selecting Print (Figure 19).
In this window are all the options you’ll need
to print slides, handouts, notes and outlines
of your presentation.

2.

The Print Window is very similar to other print
dialogues that you see in almost every other
windows program, until you get down to the
bottom third of the window. PowerPoint’s
Print Window differs in the Print What:
section, and that’s what we’ll cover here.

3.

The first drop-down box allows you to print
any of the following: Slides; Handouts, Notes
Pages or an Outline View. We’ll cover each in
more detail below.
a.

b.

c.

d.

Figure 19: Print Window

Printing Slides: This option allows you to print copies of the slides
themselves, using all the normal windows options (for quantity, series,
individual slides, etc.). This is also where you’d print slides on
transparencies so that you could give your presentation using a
standard overhead projector.
Printing Handouts: When this option is selected, it enables the
Handouts section to the right of the drop-down box. This section
allows you to conserve paper by printing multiple slides per page, in
either a portrait or landscape format. Standard layouts range from 2
to 9 slides per page.
Printing Notes Pages: In normal circumstances, notes you’ve placed on
a slide for your own purposes do not print. However, when this option
is selected, all your notes for each slide will print on a page along with
the slide itself. These printouts are usually intended for the presenter.
Printing Outline Views: Outline Views are also normally intended for
the presenter, as they don’t print slide copies, only the overview text
that’s usually displayed on the left side of PowerPoint’s “normal” view.
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OBJECTIVE 6: RE-ORDERING, RUNNING and SAVING YOUR
PRESENTATION
Once you’ve gotten your presentation into a reasonable semblance of order,
you’ll first want to run through it once or twice, then perhaps move a few slides
forward or back, and then save it so that you can use it later. These are the
topics we’ll cover now. We’ll show you how to re-order your slides, run a
sample presentation, and then save the presentation to disk or a network.
We’ll also talk briefly about the various formats that your presentation can be
saved in, such as HTML (for the Internet) and other graphical formats.

Re-Ordering Slides
1.

To re-order slides, first change your
view to the Slide Sorter View by pulling
down the View Menu and selecting
Slide Sorter. This will change your
presentation view to the Slide Sorter
View (Figure 20). All the slides in the
presentation are displayed in order(in
smaller format), and can easily be reordered from this screen.

2.

Changing the slide order is easy.
Simply click and hold on any slide, and
drag it to a position in front of (to the
immediate left of) the slide that you
want it to precede. You’ll note that a
horizontal line (usually grey in color)
indicates the final position of the slide
as you’re dragging it amongst the other
slides (Figure 21). The grey slide
positioning line is indicated by the
pointer, which shows that the slide
being moved will be inserted in
between slide numbers 2 and 3.

3.

Once the line indicating the slide’s new
location is where you want it, release
the mouse button and the slide will be
inserted at that location, and all slides
will be re-numbered. It’s that easy.
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Running a Sample Presentation
1.

An any time (as long as you’ve got slides on the screen) you can view your
presentation as though you were actually presenting it by pulling down the
View Menu and selecting Slide Show (you may also press F5). This will
“run” your presentation just like you were presenting it. You can change
slides by either pressing the SPACEBAR or clicking the PRIMARY MOUSE
BUTTON. To move back a slide, press the BACKSPACE key. If you want
to return to your previous view prior to the end of the presentation, press
the ESCAPE key.

Running a Presentation Continuously
1.

Imagine that you’ve done a PowerPoint presentation for either Open House
or Back-To-School Night. Here’s a perfect example of a presentation that
you want to run before the parents walk in the door, and you don’t want to
touch it again until they’ve all left (i.e., you want it to run continuously).
Here’s how you do that...
a.
b.
c.

d.
e.
f.
g.

First, open the presentation that you will be using.
Now let’s assign timings to each slide by pulling down the Slide Show
Menu and selecting Slide Transition.
In the Advance Box, click on the Automatically After check box, and
then input a value (in minutes and seconds) in the space provided.
Click the Apply to All button, and you now have slide timings. NOTE:
When you check the Automatically After check box, the On Mouse
Click box stays checked (if it was previously checked). The automatic
timing will work as advertised, but if you want to change a slide
sooner, a mouse click will also work.
Now let’s tell the show to run continuously without our input. Pull
down the Slide Show Menu and select Set Up Show.
Click on the Loop Continuously Until ‘Esc’ check box.
In the Advance Slides Box, click on the Using Timings, If Present
radio button.
Click OK.

Saving your Presentation
1.

It’s a good habit to frequently save your presentation as you’re working on
it, since a power failure or other unexpected problem could cause you to
lose your work at any time. To do this, pull down the File Menu and select
Save. If you haven’t given your presentation a name, do so, and you won’t
Microsoft PowerPoint in the Classroom

p. 25

2.

3.

be asked again.
PowerPoint also has the option of
saving your presentation in several
other formats. These are accessed by
pulling down the File Menu and
selecting Save As (Figure 22). The
Save As dialogue box has several
options in the Save As Type drop-down
box that we will explore below.
The Save As Type drop-down box allows
you to save your presentation in several
Figure 22: Save As Window
differing file formats. Some are merely
for users of differing versions of PowerPoint, while others save the
presentation into file formats usable by different programs. The one’s we
will discuss below are: Web Page (*.htm, *.html); JPEG File Interchange
Format (*.jpg); and Outline/RTF (*.rtf).
a.

Saving your Presentation for the Internet (HTML): When you select File,
Save As, and select Web Page as your file type, the document created
will be viewable by almost any Internet/Web browser software
available (i.e., Microsoft’s Internet Explorer or Netscape’s Navigator).
This is an easy way to distribute your presentation to colleagues who
might not have PowerPoint loaded on their computers. Selecting this
method will place a single file with the extension HTM into the
directory in which you are currently saving your presentation, and it will
also create a new directory containing additional files and graphics.
Web documents create a lot of files, as graphics and text are most
often stored separately. Don’t be surprised if this new directory
contains many more files than you have slides in your presentation.

b.

Saving your Presentation in JPEG format: JPEG is a file format normally
associated with graphic images. This option will allow you to create a
separate JPEG file for each slide in your presentation, or only the
current slide. Regardless of which option you choose, only one slide
can be created per file, so if you have a 20 slide presentation (and you
tell PowerPoint to create all slides as JPEG files), you’ll have 20 more
files on your computer. PowerPoint will create a new directory (in the
current directory where you’re saving things), with the same name as
your PowerPoint file name, and in that directory will be the individual
files for each slide. The files will have names like Slide1.jpg,
Slide2.jpg, etc. Using the JPEG file format allows other programs, such
as Word Processors, and Desktop Publishers, etc. to have access to
individual slides.
Outline/RTF: RTF (Rich Text Format) is a generic word-processing file
format, which is readable by all currently available word processing

c.
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software. Selecting this option will allow you to save the outline
portion of your presentation (the left side of the screen in the Normal
View) into an RTF document. You can retrieve this RTF file into any
word processor and freely incorporate your outline into a new or
existing document.
OBJECTIVE 7: DOWNLOADING PRESENTATIONS FROM THE INTERNET
Now that you know how to use PowerPoint, wouldn’t it be easier if someone
had already prepared the presentation for you? Of course it would! There are
lots of Websites that offer free PowerPoint presentations that you can
download and show free of charge. While most are presentations much like
you’ll be doing in your workshop (slides), some are completely interactive, like
Jeopardy games. The possibilities are limitless! In this objective, we’ll show
you how to download presentations from the Internet, and we’ll also list some
sites that have presentations available for download.

Downloading Presentations
1.

After you’ve located a Website that has
presentations for download, it’s really
pretty simple to get it down to your
PC’s hard disk. First, let’s locate a slide
show that we want to download. For
this example, we went to
http://www.google.com and used
“powerpoint presentations for teachers”
as our search phrase. That produced a
listing of sites shown in Figure 23.
From this listing, we’ll use a link that’s
not displayed in Figure 23. That link
was labeled Cyber Exchange. Clicking
Figure 23: Google Search Results
on that results took us to the following
URL: http://208.183.128.3/ce/ppt.htm. From that starting page, we
clicked on a link labeled Presentations for Grades K-2.

2.

On this new page (http://208.183.128.3/ce/ppt1-2.htm) there are 31
PowerPoint presentations available for download. For purposes of this
lesson, let’s choose the presentation on Dinosaurs. But before you
download it to your hard disk, you’ll need to think about where to put the
file. Hard disk file organization is not within the scope of this lesson, and
it’s a very personal thing. Let’s leave it at this: You should have a place
set aside on your hard disk (a special directory/folder) in which you put
untested PowerPoint presentations that you’ve downloaded from the
Internet – and a SEPARATE place to put those presentations that you’ve
reviewed and chosen to keep. For our purposes, we’ll use a directory called
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C:\PowerPoint Untested.
3.

First, scroll down the page until you can clearly see
the entire cell with the Dinosaur presentation
information in it. Then, move your mouse pointer
over the Download the Presentation link. Instead
of clicking on the link, RIGHT-CLICK on it, and let’s
take a look at the resulting menu (Figure 24).
We’re most interested in the Save Target As... link
(this link may be labeled Save Link As... in other
Figure 24: Save Target As...
browsers). This link is the easiest way to
download presentations, as clicking on it will bring
up a Save As window and allow you to save the presentation to your hard
disk. It’s always easiest to download the PowerPoint file in it’s native
format (with a .PPT extension). An easy way to see which link is to the
.PPT file directly is to look at the bottom of your browser window when you
roll your mouse over the hyperlink on the page. For instance, when the
mouse is on the Download the Presentation link for the Dinosaur
presentation, the bottom bar of Internet Explorer shows me that the link is
to the following URL: http://208.183.128.3/ce/k-2ppt/dinosaur.ppt. Since
the filename ends in .PPT, we know it’s a PowerPoint file, so that rightclicking on the link and selecting Save Target As... will save the
PowerPoint file directly to our hard disk. So go ahead and right-click on the
Download link, and click on Save Target As...

4.

When you click on the Save Target
As... menu item, a Save As window
appears (Figure 25), and we can now
save the PowerPoint file to the directory
we’ve selected (C:\PowerPoint
Untested). You’ll notice the filename is
already set for you (you can change it,
but if you do, don’t change the .PPT
extension), so all you really need to do
is click the Save button and you’re done.

5.

To review the presentation later, just
Figure 25: Save As Window
launch PowerPoint and open it using the
Open selection on the File Menu. You’ll
have to navigate to the directory into which you downloaded the
presentation, but that’s the easy part!
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Suggested Links:
Cyber Exchange . . . . . . . . . . . . . . . . . . . . . . . . . . http://208.183.128.3/ce/ppt.htm
Lots of free presentations for download, divided by grade level.
PowerPoint for Teachers . . . . . . . . . . http://www.theteacherspot.com/powerpoint.html
This site aggregates many other sites that have PowerPoint content for
teachers.
Nebo School District, Spanish Fork, UT . . . . . . . . . . . http://www.nebo.edu/nebo/ppt/
A school district offering lots of presentations by grade level.
Netsquirrel.com . . . . . . . . . . . . . . . . . . . . . . . . . . . http://netsquirrel.com/classroom/
Patrick Crispen’s PowerPoint presentations for educators. Mr. Crispen
is an educational technology specialist, so most of his presentations
have to do with technology in the classroom – warning, we all might
learn something!
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